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Word Processors
A word processor, also referred to as electronic word processor, is application software that enables the user to create, edit, format and print text-rich documents.
Word processing is the art of creating, saving, editing, formatting and printing text and graphic documents.
Examples of Word processors
· Microsoft word
· Open Office Writer
· Corel WordPerfect
· Lotus Word Pro
· Apple Works
Advantages of electronic word processors over manual typewriters
1. It is easier and more efficient to use due to automated features such as word wrap, auto text and autocomplete.
2. They have superior editing tools such as thesaurus, autocorrect, spelling and grammar checkers.
3. Electronic word processors provide predefined features for generating headers, footers, indexes, footnotes and references.
4. Most word processors have ability to create and import tables, text and graphics from other programs.
5. With electronic  word processing , it is possible to print multiple copies once
6. Word processors have superior document formatting features.  Formatting refers to the art of making the document more attractive and appealing to the eye. Such features include underlining, boldfacing, italicization, applying different colors etc.
7. Can store document for future retrieval
8. They have superior formatting features that make a document more appealing to the reader.

Word processors features
1) Title bar- indicates the task currently running. On its right are the  minimize, restore and close buttons.
2) Menu bar- provides the user with groups of commands. Each command has a drop down list with command used to create or manipulate a document.
3) Toolbars- consist of buttons of commands that provide shortcuts to commands available in the menu bar. There are two default tool bars:
· Standard tool bar – contain commands used to carry out common task
· Formatting tool bar- used to make document more appealing
4) Document window- This is the work area where you create your document.
Status bar- This is an interactive strip at the bottom of the screen that acts as a communication link between the user and theapplication program. It displays the current page, section, line and activities such as file saving progress.

5. Scroll bars- There are two scroll bars, horizontal and vertical scroll bars. They are used for navigating the document. Vertical scroll bar is used for navigating the document up or down while horizontal scroll bar are used for navigating the document left or right.  Scroll bars have scroll arrows at the end.
6. Task pane
When you launch word 2003, a task pane is automatically displayed on the top right of the window. Task pane contains shortcuts to commonly performed tasks such as opening recently used documents.
9. Rulers
Microsoft word provides users with vertical and horizontal onscreen rulers. They are used for setting margins.
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[bookmark: _Toc412536653]PURPOSE OF WORD PROCESSING
Mostly word processors are used for writing letters, reports, projects, books, essays, memos curriculum vitae, e.t.c.
CHOOSING A WORD PROCESSOR
Before choosing a word processor, consider the following factors.
1. The type of operating system
2. It should be user friendly
3. It should have good formatting and editing features.
[bookmark: _Toc412536654]CREATING DOCUMENTS USING A WORD PROCESSOR.
STARTING MICROSOFT WORD.
1. Click on start button
2. Point to all programs, click on Microsoft office and choose Microsoft word 2003 (or 2007).
[bookmark: _Toc412536656]CREATING A WORD DOCUMENT.
You can create a document using either two methods.
1. A blank document
2.  A template
A template is a predefined format for creating documents like memos and faxes. 
[bookmark: _Toc412536657]SAVING A DOCUMENT
1. Click on the file menu.
2. Click on save as
3. In the box labelled file name, tye the name you want
4. In the box labelled save in, select the drive or location you want to save in.
5. Click on the word save.
[bookmark: _Toc412536658]PROTECTING THE DOCUMENT WITH A PASSWORD.
A password is a combination of characters that prevent other users from opening and changing a document without permission of the owner.
1. Click on the file menu.
2. Click on save as
3. Click on tools .
4. Choose general options. 
5. Type a password to open and click on ok
6. Retype the same password again to confirm.
7. Click on ok.
A password is case sensitive always note the combination of characters used.
[bookmark: _Toc412536659]CLOSING THE DOCUMENT
a. Click on file menu
b. Click on close
Or Click on the X at the top right corner of the window.
[bookmark: _Toc412536660]OPENING AN EXISTING DOCUMENT.
1. Click on the file menu.
2. Click on open. 
3. Choose the location you saved in
4. Choose the file name you had typed
5. Click on open.                  OR.
You can Also open a file from a list under the file menu where word keeps the most recently used files.
[bookmark: _Toc412536661]EXITING FROM WORD
1. Save any changes you have made to your work.
2. Click on file menu, click on exit.
[bookmark: _Toc412536662]EDITING WORD DOCUMENTS.
Editing refers to making necessary changes to an existing document. These are spellchecking, undo and redo, find and replace, deleting, inserting and overwriting commands.
BLOCK OPERATIONS ON TEXT.
[bookmark: _Toc412536663]Highlighting a block of text.
The purpose of selecting or highlighting text is to enable the user to manipulate the selected block of text. You can either select using a mouse or a keyboard.
Selecting with a mouse.
To select a text or a group of text, place the mouse pointer at the beginning of the paragraph, when it changes to an I-beam, drag the I beam over the text to be selected till you reach the end.
Selecting with a keyboard
1. To select one word, move the insertion pointer to the start of the word and press Shift+Ctrl+Right or Left arrow.
2. To select one line, press Shift+Up or Shift+down.
3. To select an entire page, Press shift +page down or Shift+page up.
4. To select an entire document, press Cntrl+A or press the cursor at the beginning of the document.

[bookmark: _Toc412536664]Editing modes.
There are two editing modes in a word processors that assist the user in editing individual characters in a document. These are the insert and Type over mode.
Insert mode.
This is the defaulht mode in a word processor. In this case, when the text is inserted between words or characters, it pushes the existing text to the right as you type.
Type over mode
It is also called the overtype mode. When text is typed between existing words or characters, the new text automatically replaces the text on the right.
N.B. To switch between type over and insert mode, simply press the insert key on the keyboard.
Deletin text.
To delete a character from the right to the left, 
1. Place the insertion pointer on the right of the word.
2. Press the backspace key.
To delete a character to the right of the cursor position, 
1. Place the insertion pointer on the left of the word.
2. Press the delete key.
               To delete a block of text.
1. Highlight the text to be deleted.
2. Press the delete/del key.
Restoring deleted text.
To restore text that has just been deleted by mistake, click on edit menu, then the undo command.
[bookmark: _Toc412536665]Copying and moving blocks of text.
Copying means creating a duplicate of text or an object, while moving means changing the position of text or an object in a document. 
To copy a block of text.
1. Highlight the text.
2. Click on home menu, click on copy
3. Position the mouse pointer where you want to put the new text.
4. Click on home menu, click on paste.
NB: To use shortcut keys, press Ctrl + C to copy, then Ctrl + V to paste
[bookmark: _Toc412536666]Moving blocks of text.
1. Highlight the text.
2. Click on home menu, click on cut
3. Position the mouse pointer where you want to put the new text.
4. Click on home menu, click on paste.
NB: To use the keyboard shortcut keys, press Ctrl + X to cut, then Ctrl +V to paste
[bookmark: _Toc412536667]Find and replace
This is a feature that is used to look for a word in a large document and substitute it with another word .
Click on home menu
1. Click on find 
2. Type the word you want to find
3. Click on replace.
NB: you can use the keyboard shortcut Ctrl+F to find.
Search Options

1. Match case
This identifies only text that matches in case with that in the find what box e.g. it will not find the word DEEN if you type deen and selected the match case option.
2. Whole Word
Searches for a word or phrase that is whole. If it is part of another word it will not be found, e.g the word ever will not be found in words like however, whenever etc.., during the search.
3. Use wildcards: Wildcards are special symbols such as * and ?that are used to represent a set of words with certain characters in common. E.g names like Jeff, Joe, Jane can be represented using a wildcard as J* which means all names starting with J.
4. Like: Searches  for words which are similar in pronunciations e.g. fare and fair.
[bookmark: _Toc412536668]Proof reading
This refers to checking whether the document has spelling mistakes. It is done using two features. 
A) Spelling and grammar and autocorrect.
 The spelling and grammar checker is an inbuilt tool that helps the user to correct spelling errors and incorrect grammar structures. The  checker can only recognise errors of those words whose correct spelling is in its dictionary. 
1. Click on review
2. Click on spelling & grammar
3. In the box written fragment, check for the wrongly spelt word.
4. Replace with the word in the suggestion box if it’s correct.
5. If the word in the suggestion box is wrong, click on ignore.
[bookmark: _Toc412536669]Thesaurus
This is an editing tool that helps the user find words or phrases with `similar meanings (synonyms) or opposite meaning (antonyms) to the one selected.
1. Select the word you want to check for meaning.
2. Click on review menu
3. Click on thesaurus.
4. Right click on the one you want and click on insert.
Autocorrect                                                                                                                                                                                                                                                                                                                                                             
Autocorrect automatically detects wrongly spelled or capitalized words and replaces them with the correct word. The setting of autocorrect are user defined, e.g. if a person keeps on typing the word certain as certain, set the autocorrect  feature to replace the later with the former.
[bookmark: _Toc412536670]Autocomplete and autotext
Auto complete is a feature that displays a complete word when the user types the first few characters of the word. This helps the user to type faster by simply accepting the suggested word if indeed it’s correct.
Undo and Redo
Undo reverses the most recently executed command while redo reverts back to the cancelled action.
To undo and redo
On the Edit menu, click Undo or Redo, alternatively, press Ctrl+Z to Undo, or Ctrl+Y to redo
[bookmark: _Toc412536671]Formatting word documentsU
Formatting refers to enhancing the appearance of a document. You can format text to change text colour, underlining, boldening, italicizing, and making a character (s) superscript or subscript. Before you can format anything, you first need to highlight the words you want to format. Most of the formatting is done using formatting tool bar or format menu.
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1. 
1
	
2. Bold
3. Italics
4. Underlining
5. Subscript
6. Superscript
7. Size
8. Change case
9. Colour
10. Left alignment
11. Bullets
12. Centre alignment
13. Numbering
14. border
[bookmark: _Toc412536672]CHANGE CASE.
Its used to change from one case to another. There are several cases. 
1. Sentence case – All the first characters in a sentence are in uppercase. 
2. Lowercase – all characters are in small or lower case
3. Uppercase – all letters are in capital 
4. Title case – all the first characters in each word are in capital letters.
5. Toggle case – it changes uppercases to lowercase and vice versa.

[bookmark: _Toc412536673]SUPERSCRIPT
A superscript is a letter that appears on top of the others in a word e.g. in cm2 (2 is a superscript)
[bookmark: _Toc412536674]SUBSCRIPT
A letter that appears below the others in a word e.g. H20 (2 is a subscript)
To make text superscript or subscript:
I. Highlight the character(s)
II. On the format menu, click font.
III. On the Font dialog box select Superscript or Subscript.
Paragraph formatting
A paragraph is a separate block of text dealing with a single them and starting on a new line or indent. Some of the formatting features you can apply onto a paragraph include alignment, drop cap, indenting, line spacing and setting breaks.

Formatting text attribute;
By using formatting tool bar, you can change:
Font
To change font type and size, scroll down the font list box and select a font type.
Bolden text
Bolding makes the selected text appear darker than the rest of the text.
Underline text
Underlining refers to placing a line at the base or bottom of a word or a phrase.
Italicizing text
To italicize is to make the text slant forward.
Changing font color
The default color is black. You can font color for example to red, green, or blue.
The following are keyboard shortcuts to apply font styles:
To bold press Ctrl + B
To italicize press Ctrl + I
To underline press Ctrl + U
Alignment
Alignment is the arrangement of text relative to the margin. The five major alignment options available are left, center, right, Justified and Distributed.
Left alignment
Lines of text are lined up evenly along the left margin, but unevenly at the right margin. This is the default alignment. To align left:
1. Highlight the paragraph
2. On Format menu, Select Paragraph
3. Select left from the list box.
Right alignment
Lines of text are lined up evenly along the right margin but unevenly at the left margin. To align right:
1. Highlight the paragraph
2. On Format menu, select Paragraph.
3. Select Centered on the list box.
Center alignment
The lines of text are centered unevenly between the left and right margins.

Justification
The text is arranged evenly along the left and right margins. Typing begins at the left margin and the text must reach the right margin.
Highlight the paragraph.
On the Format menu, Select Paragraph
Select Justified on the list box

[bookmark: _Toc412536675]DROPCAP
This makes the first character of a paragraph large, taking more space in the next line.
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The two types of Drop cap are dropped and in margin.
In dropped cap the initial letter is made to occupy space in a number of lines below it whereas in in margin the initial letter occupies space on the left margin.
TABS.
Refer to constant intervals for an insertion pointer when the tab key is pressed. Tabs are used to create data in column form.1, click on page layout, click on paragraph, click on tabs.
[bookmark: _Toc412536677]LINE SPACING
Refers to the vertical distance between the lines of text. The default line spacing is single space. Character spacing refers to the space between characters in a text.
Procedure
· Highlight the text
· Right click on it
· Click the down arrow from the Line Spacing List box and select the spacing required.
[bookmark: _Toc412536678]BULLETS AND NUMBERS.
These are used to create ordered lists.
1.Highlight the text
2. Click on home menu, click on bullets tab and choose the numbering option you want.
[bookmark: _Toc412536679]PAGE AND DOCUMENT FORMATTING.
Page and document formatting refers to formatting individual pages or an entire document. This includes subdividing a page into columns, page setup, page numbering, inserting headers and footers, inserting footnotes and inserting endnotes. A header is anything that appears at the top of every page in a document. Footer appears at the bottom of every page in a document. Footnotes and endnotes are used in large documents to explain, comment on or provide reference for text in a document. Footnotes appear at the bottom of a page while the endnotes appear at the end of a section of the document.
[bookmark: _Toc412536680]Page numbers
Page numbers are used to organise a large document for ease of reference. Click on insert menu, click on page number and choose the location of the page number e.g. top, bottom left or right.
Using Keyboard Shortcut
· To bold press Ctrl + B
· To italic press Ctrl+I
· To underline press Ctrl + U
Indenting paragraphs
Indentation refers to moving the text away from the margin. You can indent the first sentencein paragraph (first line indent), the whole paragraph (full indent), or the rest of text except the first line (hanging indents).
Procedure
· Select the paragraph to be indented
· Right click on it 
· Click the down arrow in the list box under Special and select First line.(the type of indent you want)
· Specify by how far the paragraph is to be indented from the margin
Setting Margins
Margins are blank spaces around the edges of the page. To set up margins.
1. On the file menu, click page setup. Page setup dialog box  appears.
2. Click the margins tab.
3. Enter the values for the left, right and bottom margins in the respective boxes.
4. Click OK.
[bookmark: _Toc412536681]Orientation
This is position of the page in relation to the text or graphics. There are two types of orientation available. These are portrait and landscape orientation. The default, however, is the portraitorientation.
Changing orientation
I) From the File menu click on page Setup
II) Select the desired orientation at the orientation section
III) Click ok
N.B. Gutter- This is additional space to the right or left margin provided for binding. It also refers to the space between columns.
CREATING AND MANIPULATING TABLES.
A table is made up of rows and columns of cells. It is used to organize and present information. It can be inserted on the document or drawn by a pencil.
Creating a table. 
1. Click where you want the table to appear.
2. Click on insert menu – click on table. –click on insert table.
3. Choose the number of columns and the number of rows.
 Performing arithmetic calculations in a table. 
1. Click on the cell where you want the answer to appear. 
2. Click on layout menu
3. Click on formula.
4. Type a formula. E.g =sum(left) or =sum(above)
Create the table  below as it appears and use it to answer the questions that follow. Save it as Table.
Table1.14: Creating a table
	Item
	Price per Item  in Ksh
	Quantity
	Amount Paid

	Bread
	35
	5
	

	Milk
	36
	10
	

	Wheat Flour
	150
	7
	

	Cooking Fat
	285
	3
	

	Total Amount Paid
	
	
	



Calculate the following
a) Amount paid per item.
b) Total amount paid
c) Sort the time in ascending order
NB: There are two ways of creating a table
· Inserting the table
· Drawing the table
Mail Merge
Mail merge is a feature in the word processor that enables the user to create a standard letter and combine it with the address of multiple recipients at same time. The standard letter canbe  in form of a letter, an email, envelopes, labels ordirectory, and the address are  the data source or the address book
Mail merging involves three steps:
1. Creation of the main document (primary file). E.g. a letter or a memo.
2. Creation of  the data source (secondary file) i.e. address list
3. Insert the merged fields
4. [bookmark: _Toc412536683]Merge the two files. (Merged file)

NB:  A merged file is a combination of the primary file  and the secondary file.

Benefits of mail merging
· Uniformity in the letters produced
· Faster production of letters
· There is backup of the letters and data source in the computer storage location
Inserting graphics and special symbols.
The term graphics refers to all the non-text images generated by a computer. This includes photographs, drawings and graphs. Graphics present information in a form that is easy to understand. You can insert a graphic from a scanner, clipart or from the drawing tools. A osymbol is a special character that is not included on the standard keyboard. All these graphics are got from the insert menu.
[bookmark: _Toc412536684]PRINTING WORD DOCUMENTS

The main purpose of a word processor is to create documents for distribution. A document can be distributed electronically through email (soft copy) or be printed as a hard copy. To get a hardcopy, your computer must be connected to an online printer. 
1. Click on file menu or the office button at the top left.
2. Click on print
3. Choose the pages to be printed.
4. Choose the number of copies you desire.
5. Click on ok.
[bookmark: _Toc412536685]Using print preview.
Print preview help the user to see how the printed document will appear after printing. This is to repair any errors that may arise.
[bookmark: _Toc412536686]Common print related problems.
1. Lack of two-way communication-due to poor installation of the printer software (drivers) or due to the printer being turned off.
2. Paper jams due to use of poor quality of paper 
3. Poor quality due to poor quality ink or toner.




image2.png
Standard toolbar Formatting toolbar





image3.emf
 


image4.png
Calibr (Body)

B U

English

(. SP &) = F ki ABbCcDe | AaBbCEDC AaB AaBbCcDC A2BbCcDC A0BHCCDC -
e x, x Aa|[¥- A Thomsl |TNoSpsci. Hesdingl Hesding? T Subtie SustieEm. Emphssis Intensef. Stong  Quote a
e e &
°





image5.png
reat

Lines to drop: 3
Distance from text: 0"

oK

=N

| 5]

« o n





image1.jpeg
menu bar horiziontal
, ruler
/ task pane Minimize "eStore

work area

vertical scroll
sl

nArizontal scroll




